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Outline

This application note describes the sample programs for enabling RZ/T1 group devices that are equipped with a built-in

engine to serve as EtherCAT® slaves that are used to control industrial AC servo motors or other devices with
EtherCAT communication via PLC.

The features of the sample programs are as follows:

e The sample programs run with the Cortex®-R4 and Cortex®-M3 cores. The Cortex-M3 core handles EtherCAT
communication, and the Cortex-R4 core handles generation of data to be sent to the EtherCAT master and display of
received data with LEDs. A shared memory driver is used for communication between the CPUs.

e An EtherCAT communication program is created by using the Beckhoff SSC Tool (EtherCAT slave sample code
generation tool). The SSC Tool project file and ESI file, and patch file that corrects the sample program coding
(such as the sections that depend on the RZ/T1 hardware) are provided.

e The following two sample programs are provided:

(1) Simple I/O controller sample program for 32-bit I/O processing (hereafter, I/O controller sample program)
(2) Sample program for verifying the CiA402 drive profile (hereafter, CiA402 sample program)

Target Devices
RZ/T1 group devices with a built-in R-IN engine.
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1. Specifications

Table 1.1 lists the peripheral modules to be used and their applications. Figure 1.1 shows the operating environment.

Table 1.1 Peripheral Modules and Applications

Peripheral Module Application

Clock generator Supplying the CPU clock and low-speed on-chip oscillator clock

EtherCAT slave controller Handling EtherCAT communication

Ethernet MAC (ETHERC) Handling EtherCAT communication

Interrupt controller (ICUA) Handling EtherCATSlave interrupts (EtherCAT and EtherCAT
Sync0) and compare match interrupts (CMIO and CMI1)

Compare match timer (CMT) Handling the cycle counting of the compare match timer

Extended internal RAM Shared memory area (Data RAM) and memory area for the
program of the Cortex-M3 (Instruction RAM)

Error control module (ECM) Initializing the ERROROUT# pin

General-purpose input/output ports  Pins which control LED display and key entry

Host computer*’

J1
USB
(Host/Func)

EtherCAT

Mic/
headphones

RZ/T1 Evaluation Board
Serial RTK7910022C00000BR

Note 1. Indicates the device that the user needs to prepare

DC5V output
AC adopter
(accessory)

Figure 1.1 Operation Environment
Note: For connection with the EtherCAT master, use the LAN interface J1 (EtherCAT1 port).

RO1AN3071EJ0110 Rev.1.10 Page 3 of 31
Aug. 31, 2018 RENESAS



RZ/T1 Group

EtherCAT Sample Program Implementation Guide

for Devices with a Built-in R-IN Engine

2. Operation Environment

The sample programs described in this application note assume the environment below.

Table 2.1 Operation Environment

Item Description

Board RZ/T1 Evaluation Board
RTK7910022C00000BR

CPU RZ/T1 (with a built-in R-IN engine)
R7S910017

Operating frequency

CPU clock (CPUCLK): 450 MHz (Cortex-R4)
System clock (ICLK): 150 MHz (Cortex-M3)

Operating voltage

33V

Operating mode

16-bit-bus boot mode
SPI boot mode

Devices

e NOR flash memory

Macronix MX29GL512FLT2I-10Q
e Serial flash memory

Macronix MX25L51245GMI-10G
e EEPROM

Renesas R1EX24016ASASO
o Ethernet PHY

Micrel KSZ8041TL

Communication protocol

EtherCAT®

Integrated development environment

IAR Systems Embedded Workbench® for ARM Version 8.20.2

Emulator

IAR Systems I-jet

SSC Tool

Slave Stack Code (SSC) Tool Version 5.12 provided by
EtherCAT Technology Group (ETG)

Software PLC

Beckhoff Automation TwinCAT® 3
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3. Peripheral Modules
For the basics of the following items, see the “RZ/T1 Group User's Manual: Hardware”:

Clock generator, EtherCAT slave controller, Ethernet MAC (ETHERC), Interrupt controller (ICUA), Compare match
timer (CMT), Error control module (ECM), Extended internal RAM, and general-purpose input/output ports
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4. Hardware

4.1 Hardware Structure Example

Figure 4.1 shows an example of the hardware structure for the I/O controller sample program. Figure 4.2 shows an
example of the hardware structure for the CiA402 sample program.

RZ/T1
ICUA Power consumption
(Interrupt Control Unit A) Cortex-R4 reducer
| | |
CMT Cho CMT Ch1 /O Port Register-writing
protection function
PF7 P56 P77 PAO
LEDO | LED1 | LED2 | LED3
Coretex-M3 Extended internal RAM
|
Ethernet MAC
(ETHERC) EtherCAT slave controller
MIl:8 [ MII:8 CATI2C CATLED
ch0 ch1 CATLINKACT
PHY | PHY EEPROM (16k bits) EtherCAT LED
Figure 4.1 Example of the Hardware Structure for the 1/0 Controller Sample Program
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RZ/T1
ICUA Power consumption
(Interrupt Control Unit A) Cortex-R4 reducer
‘ | ‘ | ‘ |
Register-writing
CMT Cho VO Port protection function
P56 P35

LED1 SW1
Coretex-M3 Extended internal RAM

X

{

|

Ethernet MAC

EtherCAT slave controller

(ETHERC)
MIl:8 | MII:8 CATI2C CATLED
chO ch1 CATLINKACT
PHY PHY EEPROM (16k bits) EtherCAT LED

Figure 4.2

Example of the Hardware Structure for the CiA402 Sample Program
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4.2 Pins Used

Table 4.1 Pins and Functions lists the pins to be used and their functions.

Table 4.1 Pins and Functions

Pin Name Input/Output  Description

MDO Input Select the operating mode:

MD1 Input MDO =L, MD1 =L, and MD2 = L: SPI boot mode
MD2 Input MDO =L, MD1 = H, and MD2 = L: 16-bit-bus boot mode
ETH_MDIO Input/output Management data signal input/output
ETH_MDC Output Management interface clock input/output
ETHO_RXC Input/output Receive clock I/O pins

ETH1_RXC

ETHO_RXER Input Receive-data-error signal input
ETH1_RXER

ETHO_RXDV Input Receive-data-enable signal input
ETH1_RXDV

ETHO_RXDO0-3 Input Receive-data signal input

ETH1_RXDO0-3

ETHO_TXC Input 10 M/100 M transmission clock (2.5/25 MHz)
ETH1_TXC

ETHO _TXER Output Send-error signal output

ETH1_TXER

ETHO_TXEN Output Send-enable signal output

ETH1_TXEN

ETHO_TXDO0-3 Output Send-data signal output

ETH1_TXDO0-3

ETHO_COL Input Collision-detection signal input

ETH1_COL

ETHO_CRS Input Carrier-sense signal input

ETH1_CRS

CLKOUT25M0 Output External clock output for Ethernet PHY
CLKOUT25M1

PHYRESETOUT# Output PHY RESETOUT output

PHYLINKO Input PHY Link signal input (for Ether Switch)
PHYLINK1

ETHSWSECOUT Output Per-second Ether Switch event output
ETHO_INT Input Ethernet PHY interrupt-request signal input
ETH1_INT

CATI2CCLK Output EtherCAT EEPROM I2C clock signal output
CATI2CDATA Input/output EtherCAT EEPROM I2C data signal input/output
CATLINKACT1 Output EtherCAT Link / Activity LED signal output
CATLINKACTO

CATLEDRUN Output EtherCAT RUN LED signal output
CATLEDSTER Output EtherCAT Dual-color state LED signal
CATLEDERR Output EtherCAT Error LED signal output

PF7 Output Switches LED 0 on and off.

P56 Output Switches LED 1 on and off.
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Pin Name Input/Output  Description

P77 Output Switches LED 2 on and off.

PAO Output Switches LED 3 on and off.

P35 Input SWH1 input
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5. Software
5.1 Software Configuration

Figure 5.1 shows the software configuration for the sample programs.

Cortex-M3 Cortex-R4
! ' Inter-CPU ! !
YT Communication | |
! ! Sample Application *1 Sample Application
Application E i *Simple 1/0 <:::> *Simple 1/0
E H * CiA402 drive profile * Dummy Motor
S . ; .
-1 - : e e e e H
S i ! EtherCAT protocol stack | i
S ! E available by using ! '
i : BeckHoff SSCTool *1*2 | ;
- - R et et !
3 - (T ' = !
' = S :
; i £ £ :
! I g [} o \
Driver ' = = = > :
A © B |
a8 2 i
o s s :
T i ! H
i H/W H/W

Note 1. Renesas provides the EtherCAT SSC projects that has reflected the hardware-dependent
processing and necessary modifications.
Note 2. SSC Tool: EtherCAT control program generation tool provided by Beckhoff

Figure 5.1 Software Structure Example

5.2 Directory Configuration

5.21 Directory Configuration of the Sample Programs for Cortex-M3
The ¥workspace¥iccarm¥Cortex-M3 directory is the base directory of the sample programs for Cortex-M3.

Table 6.1 Directory Configuration of the Sample Programs for Cortex-M3

Directory Description
../ICMSIS Directory storing the definitions related to Cortex-M3
(CMSIS is used as is.)
../IDevice/Renesas/RIN_Engine/Include Directory storing include files
..IDevice/Renesas/RIN_Engine/Library Directory storing libraries
../Device/Renesas/RIN_Engine/Source/Board Directory storing board-dependent source files
../Device/Renesas/RIN_Engine/Source/Driver Directory storing peripheral driver source files
../Device/Renesas/RIN_Engine/Source/Project D Directory storing the projects for the 1/O controller
ual/EtherCAT_SSC_DC+hwos sample program
../Device/Renesas/RIN_Engine/Source/Project_D Directory storing the projects for the CiA402 sample
ual/EtherCAT_SSC_CiA402+hwos program

../Device/Renesas/RIN_Engine/Source/Templates Directory storing startup files
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5.2.2 Directory Configuration of the Sample Programs for Cortex-R4
The ¥workspace¥iccarm¥Cortex-R4 directory is the base directory of the sample programs for Cortex-R4.

Table 5.2 Directory Structure of the Sample Programs for Cortex-R4

Directory Description
../ EtherCAT_SSC_DC Directory storing the projects for the /O controller sample program
../ EtherCAT_SSC_CiA402 Directory storing the projects for the CiA402 sample program

5.3 Operation Overview

5.3.1 I/0 Controller Sample Program

Figure 5.2 shows a simple flowchart of the processing sequence from the start of the I/O controller sample program to
the start of EtherCAT communication.

The program for the Cortex-R4 core makes initial settings after power is supplied to the core. First, the program copies
the program code of the Cortex-M3 core, from the external flash memory to the extended internal RAM, to release the
Cortex-M3 core from the reset state. Then, the program sets the LED-controlling port pins, initializes CMTO0 and
CMT1, and specifies the periodic event and interrupt settings.

The program for the Cortex-M3 core makes initial settings after the core is released from the reset state. After tasks are
generated by HW-RTOS setup, the program starts main_task, which performs initial setup and other processing for the
EtherCAT protocol stack, and then starts sub_task.

Figure 5.3 shows a simple flowchart of the processing sequence after starting EtherCAT communication.

The program for the Cortex-R4 core reads the output counter in the shared memory by using CMTO periodic events, and
then outputs the values of the low-order four bits to LED3 to LEDO. The program also increments the input counter by
using CMT1 periodic events, and copies the value to the shared memory.

The program for the Cortex-M3 core uses sub_task to execute the main process of the EtherCAT protocol stack. The
handler for EtherCAT interrupts and EtherCAT Sync0 interrupts copies the 32-bit output values from the EtherCAT
master to the output counter in the shared memory. The handler also reads the value of the input counter in the shared
memory, and sends the value to the EtherCAT master as 32-bit input.
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C main

Cortex-R4

D

Initialization of the
red memory driver
_SHM_Irit()

Initialization of the
ortex-M3 core
init_cm3()

Port setting
port_init()

ECM setting
ecm_init()

Releasing the CMT module
from the stopped state
cmt_stanbay!

Initialization of the

Enabling IRQ interrupts by
the CPU

Setting of periodic events
R_CMT_CreatePeriodic()

—>

Releases software reset 2

Cortex-M3

C main

HW-RTOS setup
hwos_setup()

main_task is
activated.

C main_task

Initial settings for the
RSK board
board_init()

Initialization of the
shared memory driver
R_SHM_Init()

Initial settings for the EtherCAT

Initial settings for the EtherCAT

protocol stack

Activation of the sub task
sta_tsk(ID_TASK_SUB,0)

sub_task is
activated.

Figure 5.2

Simple Flowchart of the I/O Controller Sample Program (1)
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S o1 . L I
C sub_task )
—»

Main processing for the
EtherCAT protocol stack
MainLoop()

( EtherCAT interrupt )

EtherCAT interrupt handling
PDI_lsr()

return

Cortex-R4

C CMTO periodic event )

Lower-order four bits in the output
counter is output to LED 0 to 3.

return

C CMT1 periodic event )

Input counter is incremented

return

Shared memory (extended
internal RAM D)

Output counter
(32-bit output)

Input counter
(32-bit input)

EtherCAT SyncO0 interrupt

EtherCAT SyncO0 interrupt
handling
Sync0_lIsr()

( return )

B o o

~

\/

Figure 5.3 Simple Flowchart of the 1/0 Controller Sample Program (2)
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5.3.2 CiA402 Sample Program
Figure 5.4 shows a simple flowchart of the processing sequence for the CiA402 sample program.

The program for the Cortex-R4 core makes initial settings after power is supplied to the core. First, the program copies
the program code of the Cortex-M3 core, from the external flash memory to the extended internal RAM, to release the
Cortex-M3 core from the reset state. Then, the program sets the LED-controlling port pins, initializes CMTO, and
specifies the periodic event and interrupt settings.

In the main loop, the program checks whether an inter-CPU interrupt from the Cortex-M3 core has occurred. If an inter-
CPU interrupt has occurred, the program accesses the shared memory to read the TargetPosition value and copy the
ActualPosition value. The program also performs input for SW1 and output for LED1.

As pseudo motor control processing, CMTO periodic events are used to increment the ActualPosition value until it
becomes equal to the TargetPosition value while SW1 is pressed.

The program for the Cortex-M3 core makes initial settings after the core is released from the reset state. After tasks are
generated by HW-RTOS setup, the program starts main_task, which performs initial setup and other processing for the
EtherCAT protocol stack and CiA402 drive profile, and then executes the EtherCAT protocol stack.

The handler for EtherCAT interrupts and EtherCAT SyncO interrupts changes the status of CiA402, reads the
ActualPosition value from the shared memory, and then writes the TargetPosition value. The handler also generates an
inter-CPU interrupt for the Cortex-R4 core.
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Lnccccsccs s s -

Cortex-R4

= D

Initialization of the shared
memory driver
R_SHM_Init()

Initialization of the
Cortex-M3 core
init_ cm3()

Port setting
port_init()

ECM setting
ecm_init()

Releasing the CMT module
from the stopped state
cmt_stanbay()

Initialization of the CMT
channels
R_CMT Init()

Enabling IRQ interrupts by the CPU

Setting of periodic events
R_CMT_CreatePeriodic()

Inter-CPU interrupt
is generated?

Access to the shared memory

Input to SW1 and output from LED1

( CMTO periodic event )

Pseudo motor control
processing
DummyMotor()

( return )

-
1
1
1
1
1
1
1
1
1
1
1
1

Releases software reset 2

Inter-CPU interrupt is generated.

Shared memory (extended
internal RAM D)

e ————

TargetPosition
PositionActualValue
TargetVelocity

VelocityActualValue

Cortex-M3

C =D

HW-RTOS setup
hwos_setup()

main_task is activated.!

C main_task )

Initial settings for the
board
board_init()

Initialization of the shared
memory driver
R_SHM_Init()

Initial settings for the EtherCAT

Initial settings for the EtherCAT
protocol stack

Initial settings for the CiA402 drive
profile

—

Main processing for the
EtherCAT protocol stack
MainLoop()

( EtherCAT interrupt )

EtherCAT interrupt handling
PDI_lsr()

( return
( EtherCAT SyncO interrupt )

EtherCAT Sync0 interrupt
handlin
Sync0_lsr()

( return

\/

\/

Figure 5.4

Simple Flowchart of the CiA402 Sample Program
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6. Procedure for Generating Sample Programs

This chapter describes the procedure for generating sample programs. You need to prepare the EtherCAT Slave Stack
Code Tool (SSC Tool) version 5.12 for this procedure.

6.1 1/10 Controller Sample Program
(1) Start the SSC tool from the Windows start menu.
[EtherCAT Salve Stack Tool] > [SSC Tool]

(2) Create a new project.
[File] > [New]

(3) Press [Import], then select the SSC Tool configuration file for the I/O controller sample program.
\workspace\iccarm\Cortex-

M3\Device\Renesas\RIN Engine\Source\Project Dual\EtherCAT SSC DC+hwos\RenesasSDK\CONFIG\Renesas
e RZTI config.xml

The screenshot below shows that the configuration file has been imported.

Slave Stack Code Tool | New Project n
O Default

(® Custom || Reresas RZ/T1 Evaluation Board <Renesas Electronics Corp> v
Vendor: Renesas Electronics Corp. (0x766). ~
Version: 0.0.0.1

NOTE: This configuration is not provided by Beckhoff Automation and files or file
fragments may be added which are NOT covered by the license from Beckhoff
Automation GmbH.

Shall be set if the Slave code executes on an RZ/T1 Evaluation Board.

ox

Figure 6.1 Importing SSC Tool Configuration File

Imported files are registered in the custom list and will be selectable from the drop-down list from the next time.

(1) Click [OK]. Follow the dialog and import the hardware processing file (renesashw.c).
\workspace\iccarm\Cortex-

M3\Device\Renesas\RIN Engine\Source\Project Dual\EtherCAT SSC DC-+hwos\RenesasSDK\renesashw.c
(2) Select [Project] > [Create new Slave Files].
(3) Press [Start] for generation of EtherCAT Salve Stack Code.

(4) [New files created successfully] will appear on the screen for a successful generation.
\workspace\iccarm\Cortex-

M3\Device\Renesas\RIN _Engine\Source\Project Dual\EtherCAT _SSC_DC-+hwos\RenesasSDK\Src
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6.2 CiA402 Sample Program

(1) Start the SSC Tool by double-clicking on the SSC project for the target sample program.
\workspace\iccarm\Cortex-
M3\Device\Renesas\RIN _Engine\Source\Project Dual\EtherCAT SSC_CiA402+hwos\RenesasSDK\ssc_project\
RZT1-R EtherCAT demo CiA402.esp

B8 RZIT1-R EtherCAT demo CiA402 s - Slave Stack Code Tool
File Project TJool Help
ion Slave Settings
-R EtherCAT demo Cifd -
Slavelnformation ST GHE
Generic Config File Version14.10
Hardware . File name Description
EtherCAT State Machine =
Synchronisation aoeapplc AoE ADS over EtherGAT
—|- Application a0 Ih
ProcessData g L
Mailbox applinterfaceh EcatAppl EtherCAT application
Compiler bootmode ESM EtherCAT State Machine
bootmode h
bootloaderapplc Bootloader Bootloader Sample
Figure 6.2 Example of Executing the Batch Command (for the 1/0 Controller Sample Program)

(2) Select [Project] > [Create new Slave Files].
(3) Press [Start] for generation of the EtherCAT Slave Stack Code.

(4) [New files created successfully] will appear on the screen for a successful generation.
\workspace\iccarm\Cortex-
M3\Device\Renesas\RIN Engine\Source\Project Dual\EtherCAT SSC CiA402+hwos\RenesasSDK\ssc_project\
Src

(5) Prepare the patch command if you don’t have one yet.

Prepare You need GNU Patch 2.5.9 or later.

Download the patch command (version: 2.5.9) from the following web site, and then store the patch.exe file in a folder
in a search path:

http://gnuwin32.sourceforge.net/packages/patch.htm

(6) Apply the patch.
Right-click on the apply patch.bat file and select [Run as administrator] > [OK].
The patch file includes the RZ/T1-related corrections for the SSC source files.

Batch file:

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN _Engine\Source\Project Dual
\EtherCAT SSC_CiA402+hwos\RenesasSDK\apply patch.bat

Patch file:

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN Engine\Source\Project Dual
\EtherCAT SSC_CiA402+hwos\RenesasSDK\SSC CiA402 yyyymmdd.patch
Note; yyyymmdd is the date of creation of the patch file.

RO1AN3071EJ0110 Rev.1.10 Page 17 of 31
Aug. 31, 2018 RENESAS



EtherCAT Sample Program Implementation Guide
RZ/T1 Group for Devices with a Built-in R-IN Engine

BN EEE: IVUF JOYTH - apply_patch.bat

Figure 6.3 Example of Executing the Patch Command

After patching, the corrected source files are stored in the folder on the address shown below.

\workspace\iccarm\Cortex-
M3\Device\Renesas\RIN_Engine\Source\Project Dual\EtherCAT SSC_CiA402+hwos\RenesasSDK\Src
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7. Setup Needed for Connection with TwinCAT
This chapter describes how to operate the sample programs by using TwinCAT3.

Before you can start the sample programs that you created, build their source codes.

71 Copying the ESI Files

Before starting TwinCAT, copy the ESI files that are included in the sample programs to TwinCAT. The copy destination
is\TwinCAT\3.x\Config\IO\EtherCAT.

e For the I/O controller sample program

\workspaceliccarm\Cortex-M3\Device\Renesas\RIN _Engine\Source\Project_Dual
\EtherCAT SSC_DC+hwos\RenesasSDK\ESI File\RZTI-R EtherCATdemo[DC].xml
e For the CiA402 sample program

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN Engine\Source\Project Dual
\EtherCAT SSC CiA402+hwos\RenesasSDK\ESI File\RZTI-R EtherCAT CiA402.xml

7.2 Connecting to TwinCAT
Start TwinCAT3 by using the procedure described below.

From the [Start] menu, select [Beckhoff] > [TwinCAT3] > [TwinCAT XAE (VS20XX)].

After the program is started, by selecting [File] > [New] > [Project], create a new project of the TwinCAT XAE Project
type. The subsequent procedure is described below.

7.21 Setup for Reloading ESI Files
Load the ESI files of the sample program that you added from the TwinCAT side.

TwinGAT Projects - Microsoft Visual Studio {Administrator)

File Edit ‘“iew Project Build Debug  TwinCGAT | PLG  Tools Scope  Window Help
;'J'Jﬂﬂln _J_3|_! *B Generste Mappings -Hﬂl -||:§§§xﬂg&ﬂv:

[ | | B2 AE | G f=r Activate Configuration | | - d | Fzlzezi= 0 | & | 90
Restart TwinCAT System

7 so
o K Restart TwinGAT (Gontie Mode)
: . . -+ i Data Types | Interfaces | Functions
2 g Solution TwinCAT Projects’ (1 proje e e s I b I | |
;_" == | TwinGAT Froject’ *{_ Scan
"{" SYSTEM ¢ Toeele Free Bun State em Manager Chooze Tareet..
= MOTION 1
PLC " Show Online Data
- SAFETY © . Show Sub Items
ol oo an4)
= 1o iE  Access Bus Coupler/IP Link Register..
Updats FirmwareEEPROM v KHOFF @ 1986-2014
ckhoff
Show Realtime Ethernet Compatible Devices.. I
Selected Item 3
EtherGAT Devices 3

Update Device Descriptions (via ETG Website)..

Reload Device Deszcriptions...
Manaee User Defined Yihitelist

Manage User Defined Blacklist..

Figure 8.1 Reloading ESI Files

Select [Reload Device Descriptions] as in the above figure.
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7.2.2 Scanning I/O Devices

TwinGAT Project5 — Microsoft Visual Studio {Administrator)

File Edit ‘fiew Project Build Debug TwinGAT FPLC Tools Scope  Window Help

IAE-SH@ | 8 a@A|9 - E-E | b [Releas ~| | TwinGAT RT (86} || | - A e R B L
LRI TR | [3) nd|=a=0lauE|o0,

" EEEEE= T e
g % Mumber |Device |Tpe |

4 Solution 'TwinGAT Projectd’ (1 project)
B [ TwinGAT Projects

(| 5YSTEM
MOTION

B
ﬁﬁ Mapg il Add New Ttem.. Cr b Shitt+ A
i Add Existing Ttem... Shift+ Alt+A
"'f( Scan
4 Paste Ctrb

Faste with Links

Figure 8.2 Scanning I/O Devices

As shown in the above figure, right-click [I/O Device] and select [Scan] from the menu to open a window. Execute scan
in the window. After execution, perform operations as shown in Figure 8.3 and Figure 8.4.
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Microsoft Visual Studio x|

HIMT: Mot all tvpes of devices can be found automatically

wab |

1 new IO devices found /\ﬂ
W] Device 2 [EtherCAT) [0l TUFEEES (TwinCAT Intel PCI Ethemet Ada] ( | oK I >

=T

Select 4l |
Unszelect Al |

Figure 8.3 Settings for Scanning I/O Devices (1)

Microsoft Visual Studio |

Microsoft Yisual Studio |

oy This window appears only for the
| Activate Free Run CiA402 sample program.

IRTRFA() |

Figure 8.4 Settings for Scanning I/O Devices (2)
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7.2.3 Updating EEPROM Data
If the data of another application has already been written to the EEPROM, replace the data.

The following shows the procedure for replacing the data on the EEPROM:

(1) Double-click [Box 1] to display a panel on the right side of the window as in Figure 8.5.
(2) Select the [EtherCAT] tab.
(3) Click the [Advanced Setting] button.
(4) Select [ESC Access] > [EEPROM] > [Hex Editor].
(5) Select [Download from list].
(6) Select [Available EEPROM Description].
e For the I/O controller sample program
Select [Renesas Electronics Corp.] > [RZ/T1-R Slaves] > [RZ/T1-R EtherCAT Demo[DC]]
e For the CiA402 sample program
Select [Renesas Electronics Corp.] > [RZ/T1-R Slaves] > [RZ/T1-R EtherCAT CiA402]
(7) Click the [OK] button.
After the data is replaced, restart RZ/T1 (by turning it off and on, or resetting it) so that the new data is applied to the
microcomputer.
(8) Execute [Restart TwinCAT System].

RZT1-R EtherGAT demo[DC] — Microsoft Visual Studio 10| x|

Eile Edit Miew Project Euild Debug TwinGAT PLG Ieok Scope lindow bHelp
1 1 5 b | o 23 | D - = | b [Fokems ) [TcaT R G| (8] EEET =R
LB B2 NG (e | I mglrz(Et=0|amE|00 [iRE G-

MRl FZT1-R. EtherCAT dema[DC]

(= General

= General EtherGAT | Do | Process Data | Startup | GoE - Online | Online |
-2 Salution 'RZT1-R EtherCAT demo[DC] (1 project) There are no usable contrals in
2 [ RZTI-R EtherCAT demo[DC] Type: (2) [RZ7TI-R EtherGAT demo [DC] this eroup. Drag an item onto this
;\;sgém ot Revision  [TT25 7255 text 0 add it to the toolbox
; FLG futo e Addr: 0
EtherGAT Addr: [~ [1001 = [ fidvanced Settines |
Idertification Value: [0 =
: Previous Port [Wiaster =]
B 5 Device 2 (EtherCAT)
oo 2% Image
o 2% Image-Tnfo
2 Synclhnits
I e X
(1)} % Frmowestate = General 0
- #1 FrofhputTogele - Behavior
#1 SlaveCount Timeout Settings 000 30 OE 42 EE 10 00 00 00 00 00 00 00 00 0D 02 -
#1 Devitate Emz‘cfgm‘ 0010 66 07 00 00 01 04 00 00 00 0L 00 00 00 00 00
Outputs it Commands 0020 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
B Frmocl 4 il 0030 00 10 80 00 80 10 80 00 04 00 00 00 00 00 00
B FrmWicGtrl ] Distributed Glock 0040 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
: B DevCirl £ ESC Access 0050 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
@ hfoData o EPROM 0060 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
5 R Bax 1 {RZ/TI-R EtherGAT demo [DGD) Gonfigured Station  |0070 00 00 00 00 00 00 00 00 00 00 00 00 OF 00 01 00 .
B THPDO - Enhanced Link Dl |DDS0 0A 00 36 00 09 lh 52 SA 2F 54 31 2D 52 20 45 74 ..6...RZ/T1-R Et
T L % 28 et (4)[Smart View 0090 §3 65 72 45 41 54 20 64 65 6D 6F 20 5B 44 43 5D herCAT demo [DC]
: . Hex Editor 00AD 07 52 SA 2F 54 31 2D 52 16 52 65 6E 65 73 61 73 .RI/T1-R.Renesaz
o W RFDO FPGA 00BD 20 52 54 2F 54 31 2D 52 20 53 6C 61 76 65 73 08 RZ/TI-R Slaves.
: [ 32Bit Output Memory 00CO 53 79 EE 63 68 72 6F GE 02 44 43 05 54 58 50 44 Synchron.DC.TXPD
& [ WeState 00DD 4F OB 33 32 42 69 74 20 49 6E 70 75 74 05 52 78 0.32Bit Imput.Rx
o B & hfoData DO0ED 50 44 4F OC 33 32 42 68 74 20 4F 75 74 70 75 74 PD0.32Bit Outpuc
@’ Mappings 00FD 1E 00 10 00 02 00 01 OL 01 23 00 00 00 00 00 04 ... ..
0100 00 00 03 00 11 00 00 00 00 00 00 00 00 00 00
0110 00 00 00 00 23 00 0Z 00 01 02 03 FF 29 00 10
0120 00 10 80 00 26 00 01 OL &0 10 80 00 22 00 01 0Z .
0130 00 11 04 00 64 00 01 03 00 14 04 00 20 00 01 04 ....d.
0140 32 00 08 00 00 1A 01 03 00 06 11 00 00 60 00 . =
K] ;l_l

Dovnload | Read from File.. | (5)

Upload | Wite to File |

| [

Figure 8.5 Procedure for Replacing the Data on the EEPROM (1)
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T Project10 — Micrasoft Visual Studio
Eile Edit View Frojct Build Debug TwinGAT PLC Tools Scope Window Help

R A= = TR N I S | | b |Release  ~| TwinGAT RT :86) -] |
CL R rr—— CIE

MRl TwinGAT Projectl

=10/ x|

e Bl -
IR <

|

= = General
— - - General EtherGAT | DG | Process Data | Startup | GoE - Online | Gnline |
-4 Solutian TwinGAT Project!’ {1 project) There are o usable controls in
=2 .Z TwinGAT Project1l Type: [RZ/T1-R EtherGAT demo [DC] this group. Euléa; an .Aam Dn“lju this
[ | BYSTEM text te it to the t
Product/Revision:  [1025 7 258 et s T o The fonhe:
MOTION
futo e Addr [0
EtherCAT Adde [ 00T = Advanced Settines.. |
Ientitication Vale: |2 =
Previous Port [Master |
B 5 Device 2 (EtherCAT)
o 28 Inage
9 Image-Info
2 Synclnits
« L) Tnputs Advanced Settines |
& Ouputs R, EEPROV =
@ ToData = Genera _ _
4 1 Bon 1 (RZ/TI-R EtherGAT dama [06D - %Er::;rt.semm Avalable EEPROM Descriptions: I™ Show Hidden Devices @) [ |
&%) Mappings i err Beckhoff Autamation GmbH

- enfifization @ Fenesas Electronics _ raed |
L.Init Gommands | s Renesas Elestionics Corp —
Mailbe = Renesas RINT2W Slaves —
Distributed Clock Renesas RZ/T1-R Slaves
1 ESG Acsess 2 RZ/T1-R EtheiCAT CiA402 (1026 / 258)
R X RZ/T1R EtherCAT dema[0C] (1025 / 258)
Cotareed | dor with [0 000001 3h
Smart Vien
. Hex Editor
L FRGA
. Memary

Browse.

Figure 8.6 Procedure for Replacing the Data on the EEPROM (2)
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7.24

Confirming the Communication Status

Select the [Online] tab, and then confirm that the status has been changed to OP.

RZT1-R EtherCAT demo[DC] - Microsoft Visual Studio

Eile Edit Wiew Projct Build Debug TwinGAT PLO Iools Scope Window Help

= - N

=
o4 Solution "RZTI-R Ethe
- Gl RZTI-R EtherGAT
e (] SYSTEM
MOTION
PLO
~ i SAFETY

G+
B

va
2 ¥ Devices

2 Sy

[}

*
I’
*

-

&
B- @

&7, Mappires

kano-o

- -5 | b [Rekase

S o e —

-| | TwinGAT RT (xa6)

sy

S| e Bl - .

MRl FZT1-R EtherCAT demalDG]

rCAT demolDGT O project
demo[DC]

B =¥ Device 2 (EtherGAT)
o 28 Inaes
% Image-Info

icUnits

Tnputs

FrmDState
Frm0WcState
FrmOhpuiToezle
SlaveCount
DevEtate

Outputs

Frm0OCtrl
FrmDWwicCtel
DevGirl

3 InfoData
= = Box 1 (RZ/TI-R EtherCAT dema [DC])
2]

TXPDO

#1 328it Input
RxPDO

- 328it Output
WieState
InfoData

= 4|

== O i |

pREHT TN

General | EtherGAT | DG | Process Data | Startup | GoE - om@

File Access aver EtherGAT
( Davinloads Uploads

~State Machin
Baotstrap |
— | ey | Carenis
= | [EoEm | Requested State. for
DL Status——————————————————
Pert A [N Garrier / Glosed
Fort B: [No Carrier / Closed
Part G [ Garrier 7 Glosed
Part D [Wo Carrier 7 Closed

Name [ [Online [ Type [Size [ *Addre.. [ 1/Out [ User L[ Linked to -
#1 32Bit Iput 16070 UDINT 40 390 Tnput o
# WhState o BIT o1 16221 Tnput o
# TnputTosele 0 BIT 01 15241 Tput 0
# State 8 LINT 20 15480 bput 0 |
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#! DeOutputShift 1300 DINT 40 16580 Tnput o -

Figure 8.7

Note:
another operation.

Confirming the Communication Status

If the status has not been changed to OP, try [Activate Configuration], [Restart TwinCAT(Config Mode)], or
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7.3

7.31
(1) Checking 32-bit input

Sending/Receiving Data
For the I/O Controller Sample Program

Select [32Bit Input] > [Online].
You can confirm that the value is updated (incremented).

TwinGAT Project1l - Microsoft Visual Studio

il Edit Miew Project Build Debue TwinGAT PLG Tooks Scope Window Help
B = G- | b [Resass

I e R —

EMEE IR TR

-4 Solution TwinGAT Project( €1 project)
B [l TwinGAT Project1D

dll svsTEM
MOTION
PLG

B % Devices
Bl 5 Device 2 (EtherGAT)

* 8 Image

=9 Image-Info

2 Syrclhnits
Tnputs

B Outputs

& hfoData

[T (B

B L) THPDO
L. %1 32Bit Tput
£ RxPDO
Lo W 32Bit Qutput
I cState
& [ foDats
&, Mappines

2, Box 1 (RZ/T1-R EtherCAT dema [DC]

L= |

S| e Bl e
BRI

-| | TwinGAT RT t:86)

Ml TwinCAT Frojectd

= General

Variable | Flags  Online |
There are no usable controls in
this group. Drag an item onto this
text to add it to the toolbox.

Walue [14578

Force,

Mew Value:

Felesse

Comment:

| Incremented

Figure 8.8

Checking 32-bit Input Values
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(2) Specifying the 32-bit output settings

Select [32Bit Output] > [Online] > [Write].
Set a value for [Set Value Dialog], and then click the [OK] button.
The low-order four bits of the value are applied to LED3 to LEDO. (LEDs are lit when the corresponding bits are

1)

TwinGAT Project]0 - Microsoft Visual Studio =10l x

File Edit View FProect Buld Debug TwinCAT PLG Took Scope Windom Help
Pl il (G @ £ a9 - & - B1- G| b [Reease | [TwirCAT RT ta6) ] | e Bl - -

IR — [9) s @z raE0 e s & 00 . G L.

M TinGAT Projectil

= General
. : Variable | Flags  Onlie |
o) Solutian TwinGAT Project! 0 ¢ project! Thete are no usable contrals in
B [l TwinGAT Project1D Value: o this group. Drag an item onto this

[ | SYSTEM text to add it to the toolbox.
- bk New Value B i
o Gomment —

Lo | SAFETY

o [ O+

= & Yo

B “E Devices
& 58 Devics 2 (EtherGAT)

=2 Image =

£ Image-Info

2 Synolnits
Thputs Set Value Dialog x|
- Il OQutputs
& hioData Dec, [T |
B ;{ on.ljxéFSZOm*R EtherCAT demo [DCT Hex: Cancel

L #1 32Bit Input Float

£ W FxPDO
L B 32Bit Output
& ticState Bool i 1 Hex Ecit
[ hfoData | —I —I —I
&, Meppings Binary: [oF 00 00 00 1
Bit Size: C108 €16 FERCEC?

Figure 8.9 Specifying the 32-bit Output Settings
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7.3.2 For the CiA402 Sample Program
(1) Checking CiA402 status transition

Select [Control Word], set the value to 7, and then change the value to 15. Then, select [Status Word], and confirm
that the value is 0x1237, which means “Operation Enabled”.

RZTI-R GiA402 V5.1 ~ Microsoft Visual Studio
Eile Edit Mien Project Buill Debug TwinGAT FLG Jook Scope Window Help

=1 - I T R | » [Releass  ~|[TwinGAT RT &A% BN 5= e BlE -
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e
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F
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Touch Probe Position 2 Posit)
Following Error Actual Value
Digital Inputs

&+ Max Torque

. B TanetPosTTEn
&/ Position Offset
- Velocity Offsat
- Torque Offset

I+ Touch Probe Function @0 Errors | i\ 0 Warnings | (i) 0 Messages | Clear

- Positive Torque Limit Value § | | Description | File | Line | Calumn__| Praject

- Negative Torque Limit Value

- Physical outputs

5 @ WoState

4 @ TfoData

Error List - ax

RZT1-R GiA402 V511 - Microsoft Visual Studio

File Edit Wiew Project Build Debug TwinCAT PLG Took  Scope  Window Help
A= - I - R | b [Release | TwinGAT RT 686} ] = - =
e N o = | #0016 E.

Solution Explorer ~ 3 % RZTI-R CiAd02 VB x
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=] gyo
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Tputs
T Outputs
@ @ hioData
B iR Drive 1 (RZ/T1-R EtherGAT Oifd0zr
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=- i Outputs
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¢ Physical outputs
o [l WeState
5 @ hfoData

Figure 8.10 CiA402 Status Transition
Note: For details about the status transition of CiA402, refer to the “CiA402 Standards”.
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(2) Pseudo motor operation

For [Target Position], set any value as the target value.

Then, press SW1 to change the value of [Actual Position]. While SW1 is pressed, the value of [ Actual Position] is
incremented until reaching the value set for [Target Position]. When SW1 is turned off, the value of [Actual
Position] is reset to 0.

Note that while SW1 is pressed, LEDI is lit.

RZT1-R GiA402 V511 - Microsoft Visual Studio
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Figure 8.11 Pseudo Motor Operation
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8. Sample Programs

Download the necessary sample programs from the Renesas Electronics website.
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9. Reference Documents

e User's Manual: Hardware

RZ/T1 Group User's Manual: Hardware
(Download the latest version from the Renesas Electronics website.)

RZ/T1 Evaluation Board RTK7910022C00000BR User's Manual
(Download the latest version from the Renesas Electronics website.)

e Documents/Application Notes/Sample Codes
RZ/T1 Group Application Note: Initial Settings
(Download the latest version from the Renesas Electronics website.)

RZ/T1 Group Application Note: Compare Match Timer (CMT)
(Download the latest version from the Renesas Electronics website.)

RZ/T1 Group Application Note: Procedure of EtherCAT Communication for Devices with a Built-in R-IN Engine
(Download the latest version from the Renesas Electronics website.)

e Technical Update/Technical News
(Download the latest version from the Renesas Electronics website.)

e User's Manual: Development Environment
For documents of IAR Integrated Development Environment (Embedded Workbench for ARM), download the latest
version from the IAR Systems website.
(Download the latest version from the IAR Systems website.)
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Website and Support

Renesas Electronics Website
http://www.renesas.com/

Inquiries
http://www.renesas.com/contact/

All trademarks and registered trademarks are the property of their respective owners
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas.
For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as
well as any technical updates that have been issued for the products.

1. Handling of Unused Pins
Handle unused pins in accordance with the directions given under Handling of Unused Pins in the
manual.
— The input pins of CMOS products are generally in the high-impedance state. In operation with
an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
LSI, an associated shoot-through current flows internally, and malfunctions occur due to the
false recognition of the pin state as an input signal become possible. Unused pins should be
handled as described under Handling of Unused Pins in the manual.
2. Processing at Power-on
The state of the product is undefined at the moment when power is supplied.
— The states of internal circuits in the LS| are indeterminate and the states of register settings and
pins are undefined at the moment when power is supplied.
In a finished product where the reset signal is applied to the external reset pin, the states of
pins are not guaranteed from the moment when power is supplied until the reset process is
completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset
function are not guaranteed from the moment when power is supplied until the power reaches
the level at which resetting has been specified.
3. Prohibition of Access to Reserved Addresses
Access to reserved addresses is prohibited.

— The reserved addresses are provided for the possible future expansion of functions. Do not

access these addresses; the correct operation of LSI is not guaranteed if they are accessed.
4. Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become

stable. When switching the clock signal during program execution, wait until the target clock signal

has stabilized.

— When the clock signal is generated with an external resonator (or from an external oscillator)
during a reset, ensure that the reset line is only released after full stabilization of the clock
signal. Moreover, when switching to a clock signal produced with an external resonator (or by
an external oscillator) while program execution is in progress, wait until the target clock signal is
stable.

5. Differences between Products

Before changing from one product to another, i.e. to a product with a different part number, confirm
that the change will not lead to problems.

— The characteristics of Microprocessing unit or Microcontroller unit products in the same group
but having a different part number may differ in terms of the internal memory capacity, layout
pattern, and other factors, which can affect the ranges of electrical characteristics, such as
characteristic values, operating margins, immunity to noise, and amount of radiated noise.
When changing to a product with a different part number, implement a system-evaluation test
for the given product.




- Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or
elsewhere. All rights reserved.

- Ethernet is a registered trademark of Fuji Xerox Co., Ltd.

- IEEE is a registered trademark of the Institute of Electrical and Electronics Engineers Inc

- TRON is an acronym for "The Real-time Operation system Nucleus.

- ITRON is an acronym for "Industrial TRON.

- MITRON is an acronym for "Micro Industrial TRON.

- TRON, ITRON, and uITRON do not refer to any specific product or products.

- EtherCAT® and TwinCAT® are registered trademark and patented technology, licensed by Beckhoff
Automation GmbH, Germany.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.
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12.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

. Itis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third

Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by

you or third parties arising from the use of these circuits, software, or information.

Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or

arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application

examples.

No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by

you or third parties arising from such alteration, modification, copying or reverse engineering.

Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depends on the

product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic
equipment; industrial robots; etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are

not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause

serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all

liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user's manual or

other Renesas Electronics document.

When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the

reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation

characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified

ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a

certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas

Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury

or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult

and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and

sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics

products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable

laws and regulations.

Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws

or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or

transactions.

party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)
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